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Chapter 233

Superiority by a Margin
Tests for the Difference
of Two Proportions in a
Cluster-Randomized
Design
Introduction
This module provides power analysis and sample size calculation for inequality tests of the difference with a nonzero null hypothesis in two-sample, cluster-randomized designs in which the outcome is binary.

Technical Details
Our formulation comes from Donner and Klar (2000). Denote a binary observation by Ygkm where g = 1 or 2 is the
group, k = 1, 2, …, K g is a cluster within group g, and m = 1, 2, …, M g is an individual in cluster k of group g. The
results that follow assume an equal number of individuals per cluster. When the number of subjects from cluster to
cluster are about the same, the power and sample size values should be fairly accurate. In these cases, the average
number of subjects per cluster can be used.
The statistical hypothesis that is tested concerns the difference between the two group proportions, p1 and p2 .
When necessary, we assume that group 1 is the treatment group and group 2 is the control group. With a simple
modification, all of the large-sample sample size formulas that are listed in the module for testing two proportions
can be used here.
When the individual subjects are randomly assigned to one of the two groups, the variance of the sample
proportion is
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When the randomization is by clusters of subjects, the variance of the sample proportion is
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The factor 1 + mg − 1 ρ is called the inflation factor. The Greek letter ρ is used to represent the intracluster
correlation coefficient (ICC). This correlation may be thought of as the simple correlation between any two subjects
within the same cluster. If we stipulate that ρ is positive, it may also be interpreted as the proportion of total
variability that is attributable to differences between clusters. This value is critical to the sample size calculation.
The asymptotic formulas that were used in comparing two proportions (see Chapter 205, “Superiority by a Margin
Tests for the Difference Between Two Proportions”) may be used with cluster-randomized designs as well, as long
as an adjustment is made for the inflation factor.

Power Calculations
A large sample approximation may be used that is most accurate when the values of n1 and n2 are large. The
large approximation is made by replacing the values of p1 and p 2 in the z statistic with the corresponding values
of p1 and p2 under the alternative hypothesis, and then computing the results based on the normal distribution.
Note that in this case, exact calculations are not possible.

Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design and Options
tabs. For more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains the parameters associated with this test such as the proportions, sample sizes, alpha, and
power.

Solve For
Solve For
This option specifies the parameter to be solved for using the other parameters. The parameters that may be
selected are Power, Sample Size (K1), Sample Size (M1), Effect Size, and ICC. Under most situations, you will
select either Power or Sample Size (K1).
Select Sample Size (K1) when you want to calculate the number of clusters per group needed to achieve a given
power and alpha level.
Select Power when you want to calculate the power of an experiment.
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Test
Alternative Hypothesis
Specify the direction of the alternative hypothesis.
•

One-Sided (H1: D1 > D0)
Refers to an upper-tailed, one-sided test in which H1 is of the type H1: P1 – P2 = D1 > D0.

•

One-Sided (H1: D1 < D0)
Refers to a lower-tailed, one-sided test in which H1 is of the type H1: P1 – P2 = D1 < D0.

•

Two-Sided
Refers to a two-sided test in which H1 is of the type H1: P1 – P2 = D1 ≠ D0.

For one-sided tests, the direction you select must match the values entered for H0 and H1. For example, if you
select H1: D1 < D0, then the value(s) for D1 must be less than the value(s) for D0 (and the value(s) for P1.1 must
be less than P1.0).
Test Type
Specify which test statistic is used in searching and reporting. We recommend the likelihood score test.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected.
Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that
about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents
the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size – Group 1 (Treatment)
K1 (Clusters in Group 1)
Enter a value (or range of values) for the number of clusters in group one. You may enter a range of values such
as 10 to 20 by 2. The sample size for this group is equal to the number of clusters times the number of subjects per
cluster.
M1 (Items per Cluster in Group 1)
This is the average number of items (subjects) per cluster in group one. This value must be a positive number that
is at least 1. You can use a list of values such as 100 150 200.
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Sample Size – Group 2 (Reference)
K2 (Clusters in Group 2)
This is the number of clusters in group two. The sample size for this group is equal to the number of clusters times
the number of subjects per cluster. This value must be a positive number.
If you simply want a multiple of the value for group one, you would enter the multiple followed by K1, with no
blanks. If you want to use K1 directly, you do not have to pre-multiply by 1. For example, all of the following are
valid entries:10 K1 2K1 0.5K1.
You can use a list of values such as 10 20 30 or K1 2K1 3K1.
M2 (Items per Cluster in Group 2)
This is the number of items (subjects) per cluster in group two. This value must be a positive number.
If you simply want a multiple of the value for group one, you would enter the multiple followed by M1, with no
blanks. If you want to use M1 directly, you do not have to pre-multiply by 1. For example, all of the following are
valid entries: 10 M1 2M1 0.5M1.
You can use a list of values such as 10 20 30 or M1 2M1 3M1.

Effect Size
Input Type
Indicate what type of values to enter to specify the differences. Regardless of the entry type chosen, the test
statistics used in the power and sample size calculations are the same. This option is simply given for convenience
in specifying the differences.

Effect Size – Differences
Only displayed if Input Type = “Differences”
D0 (Difference|H0 = P1.0 – P2)
Specify the difference between P1.0 and P2. This value is used with P2 to calculate the value of P1.0 using the
formula: P1.0 = D0 + P2.
The power calculations assume that P1.0 is the value of the P1 under the null hypothesis. In this non-null case, the
value of P1.0 is not equal to P2 as it is in the null case.
You may enter a range of values such as -.03 -.05 -.10 or -.05 to -.01 by .01. Differences must be between -1 and
1. D0 cannot take on the values -1, 0, or 1.
D1 (Difference|H1 = P1.1 – P2)
Specify the difference between P1.1 (P1 given the alternative hypothesis) and P2. This difference is used with P2
to calculate the value of P1 using the formula: P1.1 = D1 + P2.
The power calculations assume that P1.1 is the actual value of the proportion in group 1 (experimental or
treatment group).
You may enter a range of values such as -.05 0 .5 or -.05 to .05 by .02. Actual differences must be between -1 and
1. They cannot take on the values -1 or 1.
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Effect Size – Group 1 (Treatment)
Only displayed if Input Type = “Proportions”
P1.0 (Group 1 Proportion|H0)
Specify the value P1.0 which is the group 1 proportion given the null hypothesis.
The power calculations assume that P1.0 is the value of the P1 under the null hypothesis. In this non-null case, the
value of P1.0 is not equal to P2 as it is in the null case..
Proportions must be between 0 and 1. They cannot take on the values 0 or 1. This value should not be set to
exactly the value of P2.
You may enter a range of values such as 0.03 0.05 0.10 or 0.01 to 0.05 by 0.01.
P1.1 (Group 1 Proportion|H1)
Specify the value of P1.1 which is the group 1 proportion given the alternative hypothesis.
The power calculations assume that P1.1 is the actual value of the proportion in group 1 (experimental or
treatment group).
Proportions must be between 0 and 1. They cannot take on the values 0 or 1.
You may enter a range of values such as 0.03 0.05 0.10 or 0.01 to 0.05 by 0.01.

Effect Size – Group 2 (Reference)
P2 (Group 2 Proportion)
Specify the value of p2 , the control, baseline, or standard group’s proportion. The null hypothesis is that the two
proportions differ by a specified amount (See Group 1 Proportion below).
Since p2 is a proportion, these values must be between 0 and 1.
You may enter a range of values such as 0.1 0.2 0.3 or 0.1 to 0.9 by 0.1.

Effect Size – Intracluster Correlation
ICC (Intracluster Correlation)
Enter a value (or range of values) for the intracluster correlation. This correlation may be thought of as the simple
correlation between any two observations in the same cluster. It may also be thought of as the proportion of total
variance in the observations that can be attributed to difference between clusters.
Although the actual range for this value is between 0 to 1, typical values range from 0.002 to 0.05.
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Example 1 – Finding Power
A study is being designed to study the effectiveness of a new treatment. Historically, the standard treatment has
enjoyed a 60% cure rate. The new treatment is more expensive and has more side effects than the standard
treatment. Thus, the new treatment will be adopted if it is at least 8% better than the standard treatment.
The researchers will recruit patients from various hospitals. All patients at a particular hospital will receive the
same treatment. They anticipate an average of 100 patients per hospital. Based on similar studies, they estimate
the intracluster correlation to be 0.002.
The researchers plan to use the Farrington and Manning likelihood score test statistic to analyze the data. They
want to study the power of the one-sided Farrington and Manning test at group cluster sizes ranging from 2 to 10
for detecting a difference of 0.08 when the actual cure rate of the new treatment ranges from 70% to 76%. The
significance level will be 0.05.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Superiority by a Margin Tests for the Difference of Two Proportions in a ClusterRandomized Design procedure window by expanding Proportions, then Two Proportions – Cluster
Randomized, then clicking on Superiority by a Margin, and then clicking on Superiority by a Margin Tests
for the Difference of Two Proportions in a Cluster-Randomized Design. You may then make the appropriate
entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Alternative Hypothesis ............................ One-Sided (H1: D1 > D0)
Test Type ................................................ Likelihood Score (Farr. & Mann.)
Alpha ....................................................... 0.05
K1 (Clusters in Group 1) ......................... 2 4 6 8 10
M1 (Items per Cluster in Group 1) .......... 100
K2 (Clusters in Group 2) ......................... K1
M2 (Items per Cluster in Group 2) .......... M1
Input Type ............................................... Differences
D0 (Difference|H0 = P1.0 - P2)............... 0.08
D1 (Difference|H1 = P1.1 - P2)............... 0.10 to 0.16 by 0.01
P2 (Group 2 Proportion) ......................... 0.6
ICC (Intracluster Correlation) .................. 0.002
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Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Superiority Tests for the Difference of Two Proportions (Cluster-Randomized)
Test Statistic: Likelihood Score Test (Farrington & Manning)
H0: P1 - P2 ≤ D0. H1: P1 - P2 = D1 > D0.
Group 1 Group 2
Clusters/ Clusters/ Group 2 Group 1 Group 1
Items
Items
Prop Prop|H0 Prop|H1
Power
K1/M1
K2/M2
P2
P1.0
P1.1
0.10341
2/100
2/100 0.6000 0.6800 0.7000
0.13506
4/100
4/100 0.6000 0.6800 0.7000
0.16346
6/100
6/100 0.6000 0.6800 0.7000
0.19021
8/100
8/100 0.6000 0.6800 0.7000
0.21588 10/100 10/100 0.6000 0.6800 0.7000
0.14261
2/100
2/100 0.6000 0.6800 0.7100
0.20377
4/100
4/100 0.6000 0.6800 0.7100
0.25988
6/100
6/100 0.6000 0.6800 0.7100
0.31271
8/100
8/100 0.6000 0.6800 0.7100
0.36274 10/100 10/100 0.6000 0.6800 0.7100
0.19129
2/100
2/100 0.6000 0.6800 0.7200
0.29081
4/100
4/100 0.6000 0.6800 0.7200
0.38063
6/100
6/100 0.6000 0.6800 0.7200
0.46199
8/100
8/100 0.6000 0.6800 0.7200
0.53513 10/100 10/100 0.6000 0.6800 0.7200
0.24963
2/100
2/100 0.6000 0.6800 0.7300
0.39323
4/100
4/100 0.6000 0.6800 0.7300
0.51582
6/100
6/100 0.6000 0.6800 0.7300
0.61848
8/100
8/100 0.6000 0.6800 0.7300
0.70270 10/100 10/100 0.6000 0.6800 0.7300
0.31705
2/100
2/100 0.6000 0.6800 0.7400
0.50493
4/100
4/100 0.6000 0.6800 0.7400
0.65065
6/100
6/100 0.6000 0.6800 0.7400
0.75896
8/100
8/100 0.6000 0.6800 0.7400
0.83677 10/100 10/100 0.6000 0.6800 0.7400
.
.
.
.
.
.
.
.
.
.
.
.
.
.
.
.
.
.

Diff|H0
D0
0.0800
0.0800
0.0800
0.0800
0.0800
0.0800
0.0800
0.0800
0.0800
0.0800
0.0800
0.0800
0.0800
0.0800
0.0800
0.0800
0.0800
0.0800
0.0800
0.0800
0.0800
0.0800
0.0800
0.0800
0.0800
.
.
.

Diff|H1
D1
0.1000
0.1000
0.1000
0.1000
0.1000
0.1100
0.1100
0.1100
0.1100
0.1100
0.1200
0.1200
0.1200
0.1200
0.1200
0.1300
0.1300
0.1300
0.1300
0.1300
0.1400
0.1400
0.1400
0.1400
0.1400
.
.
.

IntraCluster
Corr.
ICC
0.0020
0.0020
0.0020
0.0020
0.0020
0.0020
0.0020
0.0020
0.0020
0.0020
0.0020
0.0020
0.0020
0.0020
0.0020
0.0020
0.0020
0.0020
0.0020
0.0020
0.0020
0.0020
0.0020
0.0020
0.0020
.
.
.

Alpha
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
.
.
.

Report Definitions
H0 is an abbreviation for the null hypothesis. This is the hypothesis being evaluated by the statistical test.
H1 is an abbreviation for the alternative hypothesis. This hypothesis gives the 'true' parameter values.
Power is the probability of rejecting a false null hypothesis. It should be close to one.
K1 and K2 are the number of clusters in groups 1 and 2, respectively.
M1 and M2 are the average number of items (subjects) per cluster in groups 1 and 2, respectively.
P2 is the proportion for group 2. This is the standard, reference, baseline, or control group.
P1.0 is the proportion for group 1 (treatment group) assuming the null hypothesis (H0).
P1.1 is the proportion for group 1 (treatment group) assuming the alternative hypothesis (H1).
D0 = P1.0 - P2 is the superiority margin. It is the difference assuming H0.
D1 = P1.1 - P2 is the actual difference at which the power is calculated.
ICC is the intracluster correlation.
Alpha is the probability of rejecting a true null hypothesis.
Summary Statements
Sample sizes of 200 in group 1 and 200 in group 2, which were obtained by sampling 2 clusters
with 100 subjects each in group 1 and 2 clusters with 100 subjects each in group 2, achieve
10.341% power to detect a superiority margin difference between the group proportions of
0.0800. The proportion in group 1 (the treatment group) is assumed to be 0.6800 under the null
hypothesis and 0.7000 under the alternative hypothesis. The proportion in group 2 (the control
group) is 0.6000. The test statistic used is the one-sided Likelihood Score Test (Farrington &
Manning). The intracluster correlation is 0.0020, and the significance level of the test is
0.050.

This report shows the values of each of the parameters, one scenario per row. The total number of items sampled
in group 1 is N1 = K1 x M1. The total number of items sampled in group 2 is N2 = K2 x M2.
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Plots Section

The values from the table are displayed on the above charts. These charts give us a quick look at the sample sizes
that will be required for various values of D1.
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Example 2 – Finding the Sample Size (Number of Clusters)
Continuing with the scenario given in Example 1, the researchers want to determine the number of clusters
necessary for each value of D1 when the target power is set to 0.80.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Superiority by a Margin Tests for the Difference of Two Proportions in a ClusterRandomized Design procedure window by expanding Proportions, then Two Proportions – Cluster
Randomized, then clicking on Superiority by a Margin, and then clicking on Superiority by a Margin Tests
for the Difference of Two Proportions in a Cluster-Randomized Design. You may then make the appropriate
entries as listed below, or open Example 2 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size (K1)
Alternative Hypothesis ............................ One-Sided (H1: D1 > D0)
Test Type ................................................ Likelihood Score (Farr. & Mann.)
Power ...................................................... 0.80
Alpha ....................................................... 0.05
M1 (Items per Cluster in Group 1) .......... 100
K2 (Clusters in Group 2) ......................... K1
M2 (Items per Cluster in Group 2) .......... M1
Input Type ............................................... Differences
D0 (Difference|H0 = P1.0 - P2)............... 0.08
D1 (Difference|H1 = P1.1 - P2)............... 0.10 to 0.16 by 0.01
P2 (Group 2 Proportion) ......................... 0.6
ICC (Intracluster Correlation) .................. 0.002

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Superiority Tests for the Difference of Two Proportions (Cluster-Randomized)
Test Statistic: Likelihood Score Test (Farrington & Manning)
H0: P1 - P2 ≤ D0. H1: P1 - P2 = D1 > D0.
Group 1 Group 2
Clusters/ Clusters/ Group 2 Group 1 Group 1
Items
Items
Prop Prop|H0 Prop|H1
Power
K1/M1
K2/M2
P2
P1.0
P1.1
0.80205 84/100 84/100 0.6000 0.6800 0.7000
0.80167 37/100 37/100 0.6000 0.6800 0.7100
0.80764 21/100 21/100 0.6000 0.6800 0.7200
0.82446 14/100 14/100 0.6000 0.6800 0.7300
0.80122
9/100
9/100 0.6000 0.6800 0.7400
0.82400
7/100
7/100 0.6000 0.6800 0.7500
0.80374
5/100
5/100 0.6000 0.6800 0.7600

Diff|H0
D0
0.0800
0.0800
0.0800
0.0800
0.0800
0.0800
0.0800

Diff|H1
D1
0.1000
0.1100
0.1200
0.1300
0.1400
0.1500
0.1600

IntraCluster
Corr.
ICC
0.0020
0.0020
0.0020
0.0020
0.0020
0.0020
0.0020

Alpha
0.050
0.050
0.050
0.050
0.050
0.050
0.050

The required sample size depends a great deal on the value of D1. The researchers should spend time determining
the most appropriate value for D1.
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Example 3 – Validation
This procedure uses the same mechanics as the Tests for Two Proportions in a Cluster-Randomized Design
procedure. We refer the user to Example 4 of Chapter 230 for the validation.
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